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Copyrights
The information in this document is subject to change without notice and should not
be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for
any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or
consequential damages of any nature or kind arising from the use of this document,
nor shall ABB Oy be liable for incidental or consequential damages arising from
the use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written
permission from ABB Oy, and the contents thereof must not be imparted to a third
party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license
and may be used, copied or disclosed only in accordance with the terms of such
license.

© Copyright 2010 ABB Oy

All rights reserved.

Trademarks

ABB is a registered trademark of ABB Group. All other brand or product names
mentioned in this document may be trademarks or registered trademarks of their
respective holders.

Guarantee

Please inquire about the terms of guarantee from your nearest ABB representative.
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1. Introduction

1.1. This manual

This manual describes how to use the REF 542plus Configuration Tool program for
defining the needed actions for the remote operation.

1.2. Use of symbols

This publication includes the following icons that point out safety-related conditions
or other important information:

The electrical warning icon indicates the presence of a hazard which
could result in electrical shock.

The warning icon indicates the presence of a hazard which could result
in personal injury.

The caution icon indicates important information or warning related to
the concept discussed in the text. It might indicate the presence of a
hazard which could result in corruption of software or damage to
equipment or property.

The information icon alerts the reader to relevant facts and conditions.

The tip icon indicates advice on, for example, how to design your
project or how to use a certain function.

Although warning hazards are related to personal injury, it should be understood
that operation of damaged equipment could, under certain operational conditions,
result in degraded process performance leading to personal injury or death.
Therefore, comply fully with all warning and caution notices.

1.3. Intended audience
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1.4. Product documentation

Name of the Manual Document ID

Real Time Clock Synchronization, IRIG-B Input Time Master 1MRS755870

Product Guide 1MRS756269

Configuration Manual 1MRS755871

iButton Programmer User Manual 1MRS755863

Manual Part 3, Installation and Commission 1 VTA100004

Manual Part 4, Communication 1VTA100005

Motor Protection with ATEX Certification, Manual 1MRS755862

SCL Tool Configuration Manual 1MRS756342

Protection Manual 1MRS755860

Technical Reference Manual 1MRS755859

Technical Reference Modbus RTU 1MRS755868

Web Manual, Installation 1MRS755865

Web Manual, Operation 1MRS755864

IEC 61850 PIXIT 1MRS756360

IEC 61850 Conformance Statement 1MRS756361

IEC61850 TISSUES Conformance Statement 1MRS756362

Lifecycle Service Tool 1MRS756725

1.5. Document revisions

Version IED
Revision

Date History

A 3.0 01.03.2010 1st release, valid since V4F08x

This manual is applicable to REF 542plus Release 3.0, software version V4F08x
and subsequent.
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2. Safety information

Dangerous voltages can occur on the connectors even if the auxiliary
voltage has been disconnected.

Non-observance can result in death, personal injury or substantial
property damage.

Only a competent electrician is allowed to carry out the electrical
installation.

National and local electrical safety regulations must always be
followed.

The frame of the device has to be carefully earthed.

The device contains components sensitive to electrostatic discharge.
Unnecessary touching of the electronic components must therefore be
avoided.
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3. Project section overview

3.1. Overview

This manual provides thorough information about the new Project section of
Configuration Tool. The improvements introduced in this version allow:

* handling of a network composed of several REF 542plus devices connected to
each other via the TCP/IP protocol

* handling a new concept of project, composed of substation nodes, high-voltage
level nodes and bay nodes and also of physical devices, that is, the REF 542plus
nodes

* comparing the properties of each device
* uploading and downloading the configuration of a group of devices in the batch

mode
* downloading the firmware of the mainboard and the COM board of a group of

devices in the batch mode
* logging all the previous operations in a text file.

3.2. Project definition

Previously, Configuration Tool (ABB REF542conf) was only able to configure one
REF 542plus connected by a serial port RS232. This new version allows
configuring a network composed of several REF542plus units connected to each
other via TCP/IP.

Projects serve in handling this network. A project is a collection of .REF device
configuration files, mapping the real structure of the network. Devices are organized
under a hierarchy of nodes: Bay, Voltage Level and Substation, as shown in Figure
3.2.-1. A project is represented with a tree structure by using a Windows Explorer-
like representation.

The original ABB REF542conf window has been split into two panes where the left
one represents a new project section.
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A100658

Fig. 3.2.-1 Main window

A project is composed of a project file with the extension *.rep and a folder with the
same name as the project. The folder contains all the device-configuring *.ref files
nested in the folder, followed by a tree scheme like in Figure 3.2.-2. Every
operation on the project tree also affects the project structure on the file system.

A100694

Fig. 3.2.-2 Project file and its folder structure
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Substation and device names must be unique in a project while voltage level and
bay names must be unique in their parent node scope.

3.3. Project menu

Projects are handled via a new Project menu.

A100682

Fig. 3.3.-1 Project menu

This menu allows completing the following functions:

* creating a new project
* opening or closing an existing project
* backing up or restoring a project
* previewing a project archive
* listing the properties of each device in the project
* downloading or uploading the configuration of the devices
* downloading the mainboard or COM Board firmware to the devices
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4. Creating new projects
Create a new project by selecting New on the Project menu.

A100684

Fig. 4.-1 Project menu items

4.1. Naming new projects

* Type a name for the project in the Project Name box in the New Project dialog
window. Project name is mandatory.

* Select a folder where to save the project by clicking the ellipsis button ....

A100660

Fig. 4.1.-1 New Project dialog box
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* Add an optional project description in the text field.
* Click OK when done or Cancel to skip the project creation.

4.2. Adding elements to the project

A new project only contains the main project node.

A100686

Fig. 4.2.-1 A new project structure

New elements can be added according to the node hierarchy: project node,
substation, voltage level, bay and device.

* Add a new substation to the project node by right-clicking the node and selecting
Add substation.

A100590

Fig. 4.2.-2 New substation node
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* Add a new voltage level node by right-clicking the Substation node and selecting
Add voltage level.

A100592

Fig. 4.2.-3 New voltage level node

* Add a new bay node by right-clicking the VoltageLevel node and selecting Add
bay.

A100586

Fig. 4.2.-4 New bay node

* Add a new device by right-clicking the Bay node and selecting Add device.

A100588

Fig. 4.2.-5 A new device
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The new device is an unconfigured REF 542plus device. Therefore, its icon is a
red square with the letter U in the middle.

A100624

Fig. 4.2.-6 Unconfigured device in error state
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5. Opening and closing projects
* Select Open on the Project menu to open an existing project.

A100688

Fig. 5.-1 Project opening

The selected project is loaded and shown in the project tree section of the main
window, see Figure 3.2.-1

* Close the open project by selecting Close on the Project menu.

A100678

Fig. 5.-2 Project closing

Multifunction protection and switchgear control
unit

Remote operations

Operator's manual

REF 542plusREF 542plus1MRS757130



The ABB REF542conf window returns to the horizontal panes' mode.

A100664

Fig. 5.-3 ABB REF542conf main window with no projects open
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6. Project tree and its operations
A project is represented by a tree structure similar to a Windows Explorer tree. Each
node has its own icon. Each device node also has a status icon that depends on the
node's condition. There are six possible statuses.

1. Green tick: device OK

2. Red U: configuration file is new (not configured)

3. Red W: configuration file is wrong

4. Red I: configuration file is invalid

5. Red O: configuration file is generated by an old version of Configuration Tool

6. Red backwards E: configuration file does not exist

A100690

Fig. 6.-1 Possible device icon statuses

It is possible to modify an open project by using the shortcut menu associated with
each node. These operations are very similar in all node levels and therefore they are
grouped by type.

6.1. Importing nodes

Project nodes, substation nodes, voltage level nodes and bay nodes can all be
imported.
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* Right-click the parent node and select the option corresponding to the node in
question, for example Import voltage Level.

A100652

Fig. 6.1.-1 Node import

* In the opening dialog box, select the folder to be imported into the project.

A100650

Fig. 6.1.-2 Node importing dialog

The selected folder must be structured similarly to a correct node, that is, in case
of a voltage level node, the folder must contain one or more bay folder nodes,
and in every bay node must be at least one device. Otherwise, the import fails.

6.2. Deleting nodes

Substation nodes, voltage level nodes, bay nodes and device nodes can be deleted.
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* Right-click the parent node and select the option corresponding to the node in
question, for example Delete Substation.

A100620

Fig. 6.2.-1 Node deletion

* Click OK in the appearing dialog box that prompts for confirmation to delete the
node. The selected node is deleted from the project and also from the file system.

6.3. Renaming nodes

Project nodes, substation nodes, voltage level nodes, bay nodes and device nodes
can be renamed.

* Right-click the parent node and select the option corresponding to the node in
question, for example Rename Substation.

A100704

Fig. 6.3.-1 Node renaming

* In the opening dialog box, type the new name and click OK.
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A100702

Fig. 6.3.-2 Node renaming dialog

6.4. Copying nodes

Substation nodes, voltage level nodes, bay nodes and device nodes can be copied.

* Right-click the parent node and select the option corresponding to the node in
question, for example Copy Substation.

A100614

Fig. 6.4.-1 Node copying

The node is copied and ready for pasting. Copying is possible only if the node is
safe, that is, if there are no unconfigured devices under the selected node.
Otherwise, an error dialog is displayed.

A100616

Fig. 6.4.-2 Error dialog if the copied node is not safe
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6.5. Pasting nodes

Project nodes, substation nodes, voltage level nodes and bay nodes can be pasted.

* Right-click the parent node and select the option corresponding to the node in
question, for example Paste Substation.

A100668

Fig. 6.5.-1 Node pasting

The node is pasted in that position, see 6.5.-2. Pasting is only possible in suitable
nodes. For example, a substation node can only be pasted on a project node, a
bay node only on a voltage level node and so on.

ABB REF542conf also prevents name overlapping by adding a progressive
number in brackets after the node name that must be unique in the project, see
6.5.-2
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A100670

Fig. 6.5.-2 Result of pasting

6.6. Editing project descriptions

This operation can only be done to a project node.

* Right-click a project node and select Edit description.

A100628

Fig. 6.6.-1 Description editing

* In the opening dialog, edit the description and click OK.
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A100680

Fig. 6.6.-2 Edit project description dialog

The description text appears in the project node tooltip.

A100722

Fig. 6.6.-3 Project description in the tooltip
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6.7. Checking projects

This operation can only be done to a project node.

* Right-click a project node and select Check project.

A100610

Fig. 6.7.-1 Project checking

ABB REF542conf performs a verification on the project structure to assure the
correctness and consistency.

The verification procedure consists of a sequential procedure checking for the
device configuration correctness and for the absence of the IP and COM board
address conflicts.

The device configuration check shows the device files that are in the configuration
error condition and finds out if the project file is consistent with respect to the file
system structure.

If this check is successful, the procedure continues with the check for the IP and
COM board address conflicts inside the project.

Definitions of the check project criteria:

* An Internal IP address is an IP address assigned to the mainboard or Ethernet
board of a device file.

* An External IP address is an IP address assigned to any other device or
component that communicates with the mainboard or Ethernet board, for
example, SPA TCP or MODBUS TCP authorized clients or SNTP servers
configured for a device file.

* A COM board address is an address assigned to the communication board such
as SPA, LON, IEC, MOD-SPA (excluded Ethernet board).

The procedure checks for address conflicts according to the following criteria:
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* Internal IP address cannot be used for either another device’s internal IP address
or for any external IP address. In other words, an IP address assigned to the
mainboard and Ethernet board must be unique throughout the whole project.

* External IP address cannot be used as an internal IP address for any device.
* COM board address must be unique only inside the Substation level.

Check functionality is automatically performed just before starting each
maintenance operation. If an error is found, it must be corrected. Otherwise, no
download maintenance operations can be started.

The COM board address conflicts only block the configuration
download. In other cases, they only cause the showing of warnings.

The correction of an IP address conflict or a COM board address conflict is done
through the windows that list all the address conflicts and the devices containing the
related conflict. By double-clicking each of them it is possible to edit a new value,
and a list of the already used addresses can be shown to help the user in the choice.

The checking of other possible configuration inconsistencies is delegated to the
communication engineer via the "Device Property" dialog that allows grouping the
same configuration property for all the devices forming the project.

6.8. Expanding projects

This operation can only be done to a project node.

* Right-click a project node and select Expand project.

A100636

Fig. 6.8.-1 Project expanding in the shortcut menu

Configuration Tool expands the project tree, showing all the nodes in it.
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6.9. Going to edited devices

This operation can only be done to a project node.

* Right-click a project node and select Go to edited device.

A100646

Fig. 6.9.-1 Going to an edited device in the shortcut menu

Configuration Tool expands the project tree, showing the device currently in the
edit mode.

A100648

Fig. 6.9.-2 Device in the edit mode

6.10. Entering and exiting edit

This operation can only be done to a device node.
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* Right-click a project node and select Enter edit.

A100632

Fig. 6.10.-1 Entering edit

All the configuration menus affect the device currently in the edit mode. The
device is marked with a pencil symbol on top of its icon.

A100630

Fig. 6.10.-2 Editing mode for the device "New"

* Right-click the device in the edit mode and select Exit edit.
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A100634

Fig. 6.10.-3 Exiting edit

ABB REF542conf prevents any further modifications to its properties and
prompts for storing the unsaved modifications.

A100710

Fig. 6.10.-4 Exiting the edit mode with unsaved changes

6.11. Going to next and previous errors

This operation can only be done to a device node.

* Right-click a device node and select Go to next error or Go to previous error
to identify a device in the error state and go to it. Configuration Tool selects the
next or previous device in the error state. The menu items are only available if
devices with errors exist.

6.12. Sorting nodes

Substation nodes, voltage level nodes, bay nodes and device nodes can be sorted in
an ascending or descending order.

* Right-click a project node, select Sort and then select:
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Sort All to sort all the child nodes of the project node

Sort Substation to sort only the Substation child nodes of the project node

Sort Voltage Level to sort only the Voltage level child nodes of the project node

Sort Bay to sort only the Bay child nodes of the project node

Sort Devices to sort only the Devices child nodes of the project node

A100800

* Right-click a substation node, select Sort and then select:

Sort All to sort all the child nodes of the node

Sort Voltage Level to sort only the Voltage level child nodes of the node

Sort Bay to sort only the Bay child nodes of the node

Sort Devices to sort only the Devices child nodes of the node

A100802

* Right-click a voltage level node, select Sort and then select:
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Sort All to sort all the child nodes of the project node

Sort Bay to sort only the Bay child nodes of the node

Sort Devices to sort only the Devices child nodes of the node

A100804

* Right-click a bay node, select Sort and then select Sort Devices to sort the
Devices child noes of the node.

A100806

6.13. Dragging

The drag-and-drop operation is applicable only to voltage level nodes, bay nodes
and device nodes. It is similar to the drag-and-drop operation of files and folders in
Windows Explorer.

During dragging, a separator appears under the pointer to indicate where the node is
to be moved when the mouse button is released.
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A100808

Fig. 6.13.-1 Dragging a voltage level node

* Drag a Voltage level node under a substation type node.
* Drag a Bay node under a voltage level type node.
* Drag a Device node under a bay type node.
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7. Project backup and restoration

7.1. Backing up projects

* To create a backup copy of a project, select Backup / Restore and then Backup
project on the Project menu.

A100608

Fig. 7.1.-1 Project backup in the Project menu

A dialog window opens for selecting the destination folder for the project
backup.

* Select a folder where to save the backup by clicking the ellipsis button .... The
name of the backup file is automatically created using the name of the project,
date, time of day and the .rez extension.

A100640

Fig. 7.1.-2 Backup dialog
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7.2. Restoring projects

* To restore a project from its backup file, select Backup / Restore and then
Restore project on the Project menu.

A100708

Fig. 7.2.-1 Project restore in the Project menu

* In the appearing dialog window, select a backup file by clicking the
corresponding ellipsis button .... A backup file has the file extension .rez.

* Select the destination folder where to restore the backup file by clicking the
corresponding ellipsis button ....

A100644

Fig. 7.2.-2 Dialog for restoring a backup
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7.3. Previewing archives

* To have a preview of the structure of a project previously archived in a backup
file before restoring it, select Backup / Restore and then Archive preview on
the Project menu.

A100672

Fig. 7.3.-1 Archive preview in the Project menu

A preview of the selected .rez file is shown in the Archive Preview dialog.

Multifunction protection and switchgear control
unit

Remote operations

Operator's manual

REF 542plusREF 542plus1MRS757130



A100642

Fig. 7.3.-2 Dialog for previewing archives
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8. Device properties
The Device Properties dialog shows the properties of the devices of a project. It is
possible to select a node of the project tree, and the corresponding devices with their
properties appear in the grid on the right side of the window.

A100622

Fig. 8.-1 Dialog for device properties

The device properties are grouped under tabs, where each tab represents a set of
similar properties. Only tabs with at least one property whose value is other than
null are shown.

Double-clicking a device row in the grid allows editing the properties in the active
tab.
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A100626

Fig. 8.-2 Device property value editing
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9. Communication
The main purpose of Configuration Tool is to communicate with the devices listed
in the project. With the new project section it is possible to do batch communication
operations between the PC and the REF 542plus units. The operations are divided
into four types.

* Configuration download: This allows loading on the selected remote devices
the configuration file created in the Configuration Tool project.

* Configuration upload: This retrieves the configuration of the selected devices
from the REF 542plus units and saves it in the corresponding project in
Configuration Tool.

* Mainboard software download: This sends to the selected remote devices
the mainboard software file selected in Configuration Tool.

* COM board (LON / IEC) software download: This sends to the selected
remote devices the COM board (of the type LON or IEC) software file selected
in Configuration Tool.

Configuration Tool implements these operations with four dialogs, accessible from
the Communication menu item of the Project menu. Due to their similarity, this
manual only describes the configuration download dialog. The chapters about the
remaining three dialogs only point out the differences compared to the first one.

9.1. Downloading configurations

Application download sends the configuration file to one or more remote devices.

* To download a configuration, select Communication and then Send
Configuration on the Project menu.

A100596

Fig. 9.1.-1 Application download on the Project menu
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The appearing dialog "Send Configuration" contains the project tree on the left
side and two grids, upper and lower, on the right. In the project tree, a device
configured with an assigned IP address and the SPATCP section enabled appears
with the default HMI icon, whereas an incorrectly configured device appears
with a red X over the HMI icon.

A100598

Fig. 9.1.-2 Application Download dialog

When a node is selected in the project tree, the corresponding configured devices
appear in the upper grid with additional information. Also Read Device Info
becomes available.
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A100600

Fig. 9.1.-3 Read Device Info available

Read Device Info allows retrieving remote information from the devices listed
in the upper grid. If Configuration Tool successfully communicates with a
device, its information is shown in the upper grid, the Add All button becomes
available and the corresponding node in the project tree takes the transfer icon ,
see Figure 9.1.-4.

Otherwise an error message is shown in the Error column for each device with
problems. The row corresponding to the failed transfer device appears with a red
background and the corresponding node in the project tree takes the transfer icon
, see Figure 9.1.-5.

Information received from the REF 542plus units is locally stored and shown in
the upper grid on request. If Read Device Info is clicked when a device already
inquired is selected, a dialog asks if Configuration Tool should require again the
remote information from the unit or keep the already downloaded information.
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A100698

Fig. 9.1.-4 Device information read successfully
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A100696

Fig. 9.1.-5 Reading of device information failed

The lower grid contains all the devices to which the configuration is
downloaded.

* To add devices to the lower grid, select devices from the upper grid and either
click Add to add the selected device or click Add All to add them all.

Only devices whose information has been retrieved by clicking Read Device
Info are eligible for application download, that is, added to the lower grid.

* Click Remove or Remove All to remove some or all of the devices from the
lower grid.
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Fig. 9.1.-6 Lower grid with devices ready

* Click Start. Downloading begins, and a progress bar shows the progression.

The result of a transfer session is shown with an icon for each device on the
project tree.

Table 9.1.-1 Device state icons

Icon Description

Default state: Transfer not done

Transfer successfully done

Transfer unsuccessfully done

Error state: System error
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A100676

Fig. 9.1.-7 Configuration download in progress

If the downloads are successful, the configuration storing operation starts
automatically. New progress bars are shown.
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Fig. 9.1.-8 Storing in progress

If one or more downloads fail, it is still possible to store the correctly
downloaded configurations. A dialog prompting for this appears. The row
corresponding to the failed transfer device appears with a red background and the
corresponding node in the project tree takes the transfer icon
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A100712

Fig. 9.1.-9 Notification about failed downloads

* Click Yes to store the correctly downloaded configurations.
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Fig. 9.1.-10 Storing only the device without errors

* Click No to abort the configuration download for all devices.

A100716

Fig. 9.1.-11 Aborting the download for all devices

* Click Abort at any time during the download of a configuration to stop the
download in progress, see Figure 9.1.-7. This makes Start available again.
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A100602

Fig. 9.1.-12 Start available during User break

In case of a download failure, an error message appears in the Error/Warning
column. Start is now renamed ReStart, and retrying of download is allowed.
The row corresponding to the failed transfer device appears with a red
background and the corresponding node in the project tree takes the transfer icon
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A100594

Fig. 9.1.-13 ReStart is available and retrying of download allowed

Note that the REF 542plus Configuration Tool is able to send a
configuration to the REF 542plus device only if all the following
conditions are verified:

1. The version of REF 542plus in general must be compliant with the version of the
REF 542plus Configuration Tool.
* The REF 542plus software version must be equivalent to that of the REF

542plus Configuration Tool; otherwise, the error “Incompatible REF542plus
version!” appears.

2. Mainboard communication settings verification.
* The communication setitngs version of a REF 542plus device must be

compliant with that of the corresponding project REF 542plus configuration
file; otherwise, the error “Incompatible REF542plus version!” appears.

* The REF 542plus device TCP/IP configuration requires a correct ethernet
driver initialization (MAC address available); otherwise, the error
“REF542plus ethernet driver error. Check the MAC address!” appears.
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3. COM board verification
* If the COM board is configured for a device in the project, it must be detected

in the corresponding REF 542plus device. Otherwise, the error “COM board
configured but not detected by REF542plus!” appears.

* If the COM board is detected in the corresponding REF 542plus device, it
must be of the same type than the one configured. Otherwise, the error “COM
board detected by REF542plus different from the one configured!” appears.

* If the COMboard is detected and it is of the same type than the one
configured, it must be version-compatible in the internal data. Otherwise, the
error “Incompatible COM board version!” appears.

4. License key verification
* The license key in the device must be valid and greater than or equal to the

license key of the corresponding configuration; otherwise, the error “Missing
license rights (%s)!” appears.

5. RHMI version verification (if available)
* HMI hardware version of the device must be valid and equal to that of the

corresponding configuration; otherwise, the error “Incompatible HMI
hardware version!” appears.

6. Analog input 20mA board version verification (if configured)
* Analog input 20mA board version of the device must be valid and available;

otherwise, the error “Analog Input 20mA board not detected!”

7. CAN interface (if configured)
* CAN interface must be valid and available; otherwise, the error “CAN

controller not mounted!” appears.

Multifunction protection and switchgear control
unit

Remote operations

Operator's manual

REF 542plusREF 542plus1MRS757130



9.2. Uploading configurations

Configuration upload is identical to configuration download.

* Click Start to retrieve the remote configuration from the REF 542plus units and
save it in the selected local devices that compose the project. For other parts,
dialogs are similar here and in the cpnfiguration download.

A100604

Fig. 9.2.-1 Application Upload dialog
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Note that the REF 542plus Configuration Tool is able to load
configurations from an REF 542plus device only if the following
condition is verified:

1. The version of REF 542plus in general must be compliant with the version of the
REF 542plus Configuration Tool.
* The REF 542plus software version must be less than or equal to the one of the

REF 542plus Configuration Tool. Otherwise, the error “Incompatible REF
542plus version!” appears.

Version comparison is done on the first two digits after the dot, that is, the
comparison digits for V4F.08x are 08.

9.3. Downloading mainboard software

This dialog allows sending a software file to the mainboard of the selected remote
devices. The dialog structure is identical to that of the configuration download,
except for the addition of a text field at the top of the window and the Open SW
File button.
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A100656

Fig. 9.3.-1 Mainboard firmware download dialog

Open SW file allows choosing a software file with the extension .sre and loading it.
Software information is shown in the upper text field, and version and checksum are
shown near the file name.

Read Device Info shows information about each device. A warning is shown if the
selected mainboard software file is already running in the device.
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A100810

Fig. 9.3.-2 Result of device information reading with software file information at the top

* Click Start to download the software file to the mainboard of the remote devices
listed in the lower grid. Except for this function, the dialogs are similar to those
of the configuration download.

Restrictions: The REF 542plus Configuration Tool is able to send
software to the REF 542plus devices only if all the conditions are
verified.

1. REF 542plus Mainboard software and hardware minimum requirements
* The minimum version of the mainboard software running on the device must

be V4F.08.
* The minimum version of the mainboard hardware of the device must be 6.0.
* The minimum version of the mainboard bootloader running on the device

must be 4.2.

Only the devices without errors can be moved in the lower grid to start the
download process.

A100812

Fig. 9.3.-3 Version check after device info reading
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9.4. Downloading COM board software

COM board software download allows loading a software file to the COM board of
the selected remote devices. The dialog structure is identical to that of the
configuration download, except for the addition of a text field at the top of the
window and the Open SW File button. It allows choosing a software file with the
extension .sss and loading it. Software information is shown in the upper text field.

A100612

Fig. 9.4.-1 COM board LON software download dialog

* Click Start to download the firmware file to the COM board of the remote
devices listed in the lower grid. Except for this function, the dialogs are similar to
those of the configuration download.

Restrictions: The REF 542plus Configuration Tool is able to send
software to the COM board of an REF 542plus device only if all the
conditions are verified.

1. REF 542plus mainboard software and hardware requirements
* The minimum version of the mainboard software running on the device must

be V4F.08.
* The minimum version of the mainboard hardware of the device must be 6.0.

2. COM board verification
* Sending software operation requires that an appropriate type of the COM

board is installed and detected
* Sending software to COM IEC requires the IEC COM board type
* Sending software to COM LON requires the LON COM board type
* The COM board must be of the same type than the one configured.

Otherwise, the error “COM BOARD software cannot be downloaded.
Different COM board detected by REF 542plus” appears.
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10. Logging
ABB REF542conf allows logging all the main events generated by project section
operations in a text file. Logging is off by default.

* To activate logging, select Customize on the Options menu.

A100618

Fig. 10.-1 Customizing

* Select "Log" from the tree structure on the left of the customization dialog. On
the right side it is possible to enable logging and choose a destination folder for
the log text file.

A100654

Fig. 10.-2 Logging parameter configuration dialog
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The log is archived in a text file named using the ABB REF542conf executable
name, the word "Log" plus the current date. When logging is enabled, a new log
file is created every day. Operations are logged in a single text row in the file like
in this example:

REF542confLog_2009-08-25.txt

2009-08-25 11:29:02 – [MAIN]: Beginning REF542conf.

2009-08-25 11:38:00 – [PROJECT]: Opened a project: New Project.

2009-08-25 11:38:55 – [DEVICE]: Opened a device: New.

2009-08-25 11:38:55 – [DEVICE]: Entering edit mode for device: New.

2009-08-25 11:43:17 – [DEVICE]: Exiting edit mode for device: New.

Each logged event contains the date with units in day and hour, the section inside
square brackets and the event message.

A section represents a specific area of ABB REF542conf that groups similar
functionalities. The logged sections are as follows:

* Main
* Project
* Device
* Backup/Restore
* Drawing
* Device properties
* Application download
* Application upload
* Mainboarb FW
* COM FW
* User management
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11. User profile management
This version of Configuration Tool has the optional functionality of setting Access
Control List in order to access Configuration Tool in a secure way.

Access Control List is stored on the local disk or in a remote folder of the LAN as a
hidden user file. It consists of user profiles defined by:

* User ID
* Password
* Authorization level

User profile management enabled means that it is possible to access Configuration
Tool only after having been granted authorization in the authentication login phase.

Further, some or all Configuration Tool functionalities can be accessed according to
the user authorization level.

There are four authorization levels to ensure minimum user rights needed:

* User
* Programmer
* Engineer
* Administrator

The authorization levels and corresponding allowed operations are listed in the
table:

User Level Operations

User L1 * Load in read/only the Project
* Device properties view
* Read device info
* Upload application file (*.ref)
* Saving disabled

Programmer L2 * L1 operations
* Download application file (*.ref)
* Download FW mainboard
* Download FW COM board
* Parameter setting (like operation tool)

Engineer L3 * L2 operations
* Full access of functionality

Administrator L4 * L3 operations
* Manage user levels (assign/remove password, etc.)
* Import / export encrypted authorized user file

By default, user profile management is disabled.

11.1. Logging in

If the user profile management is enabled, Configuration Tool requires the
credentials through a login window.

Multifunction protection and switchgear control
unit

Remote operations

Operator's manual

REF 542plusREF 542plus1MRS757130



A100734

Fig. 11.1.-1 Login

* Click OK to confirm the credentials and wait for the verification response of the
system.

* Click Reset to reset the User ID and password fields.

To quit the login dialog and exit immediately from the application,
click the Close button of the window or press ALT+F4.

If a wrong ID or password is entered, an error message appears.
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A100736

Fig. 11.1.-2 Login failure

If user profile management is disabled, at startup no credentials are requested.
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11.2. Configuring user access control list

* To configure the list of users allowed to access Configuration Tool or make other
user profile operations, access the user management configuration page by
clicking Customize on the Options menu.

A100738

Fig. 11.2.-1 User manager access

* Select "User Manager" in the tree structure on the left.

A100746

Fig. 11.2.-2 User manager in the tree structure

A login dialog appears for an authentication to access the user management.
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A100740

Fig. 11.2.-3 Login dialog

* Click OK to confirm the credentials and wait for the verification response of the
system.

* Click Reset to reset the User ID and Password fields.

The Administrator authorization level is required to access this page
and manage user profiles. If the user access list has not been created
before, the only account that can be entered in the user management
configuration page is the "Super User" account.

An error message appears if a different user profile is used.

A100742

Fig. 11.2.-4 Incorrect user rights error

After a successful login authentication, the User Manager panel is shown.
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Fig. 11.2.-5 User manager panel

User Manager consists of five main sections:

* User Authorization file
* Current Status
* Users profile
* File operations on Local Disk
* File operations on Network Drives

11.2.1. Users Authorization file

A100724

Fig. 11.2.1.-1 Users Authorization file

* Enable sets Configuration Tool to operate with user access control.
* Disable sets Configuration Tool to operate without user access control by

disabling the user profile management.
* Restore default sets Configuration tool to operate with the user access control

list stored in the default folder in the local disk.
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11.2.2. Users profile

This section allows managing user profiles by adding a new user profile or editing
or removing existing profiles in the list.

A100748

Fig. 11.2.2.-1 User profiles

* Add user adds a new user to the user list.

The maximum number of users is 100.

A dialog window with the main user profile fields appears.

A100750

Fig. 11.2.2.-2 User adding dialog
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* "User ID" is the username. It is case-sensitive and cannot be longer than 15
characters.

* "Password" is case-sensitive and cannot be longer than 15 characters.
* "User Authorization Level" must be selected to complete the user profile

before closing the dialog.

User authorization level is a mandatory selection. There can be more than one
user for each level.

The first user profile must be defined as "Administrator."

* Edit edits the data of the selected user from the user list.

The edit mode can also be accessed by double-clicking a user ID on the
list.

A dialog window for editing appears.

A100752

Fig. 11.2.2.-3 User editing dialog
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User ID cannot be changed here. For a different user ID, the old user
profile must be deleted and a new profile added with the new user ID.

* Remove removes the selected user from the list.

A confirmation message appears, where clicking Yes removes the user.

A100754

Fig. 11.2.2.-4 User removing confirmation

All kinds of user profiles can be removed. However, an Administrator
profile cannot be removed with Configuration Tool if it is the only
Administrator profile in the list. An Administrator profile cannot be
removed last but there must be other user profiles left.

11.2.3. Current status

The Current status section contains information about the location of a user account
file and the profile of the user logged in.

The location of a user account file can be local or remote, depending on if a file is
used from the local computer or from a network storage.

The current profile can always be either Administrator or Super User.
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Fig. 11.2.3.-1 Current status section

11.2.4. File operations on Local Disk

A100730

Fig. 11.2.4.-1 File operations on local disk

* Import from File allows importing a user account file from local disk.
* Export to File allows exporting user account settings to an external visible file.

For both operations the path file established as default is used. All the
user management operations only affect the default user file.

11.2.5. File operations on Network Drives

* Set Default is used for selecting a user file located in a remote folder and setting
it as the default user account setting file. After this, the content of the local file is
updated with the content of the selected remote user file.

* Update allows refreshing the user list if the network file is updated by another
administrator.
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A100732

Fig. 11.2.5.-1 File operations on network drives

File operations can be done remotely.

A100700

Fig. 11.2.5.-2 Example of remote operations
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12. Configuration detection differences
During maintenance, it must be known if the configuration file stored in the PC file
system and opened in Configuration Tool is the same as the one running in the
device.

To provide this information, the functionality to detect every real change done by
the user (that is, parameters, FUPLA logic, settings and so on) has been improved.

The difference detection is based on the date of configuration modification and on
the configuration revision. Only in case both are the same in the PC configuration
file and in the device, the two configurations can be considered equal.

The date of configuration modification is updated by the configuration tool when
saving or downloading a modified configuration.

The revision consists of a major and a minor number ("m.n," default "1.0").

* The major number is increased by the configuration tool when saving or
downloading a modified and already downloaded configuration. After a revision
upgrading, the minor number is reset to "0."

* The minor number is increased by the device after every parameter update.

The configuration modification date and state ("downloaded," "not downloaded" or
"modified") and the revision are shown in the Configuration Tool main window.

The configuration modification date and the revision are shown in the HMI versions
page.

The revision parameter can also be changed in the "Global Setting" dialog.

If the configuration file includes the "Parameter Set Selector" function,
also a change on the parameter set causes an upgrade of the revision
number, that is, the minor number.

For example, a change from SET1 to SET2 or from SET2 to SET1
makes a configuration difference also if they are equal.
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13. Appendix A: Project organization and
maintenance guideline
This chapter provides advice on how to keep the project files safely organized.

A project consists of a project file with the extension *.rep and a folder with the
same name as the project. The folder contains all the device-configuring *.ref files
nested in the folder, followed by a tree scheme like in Figure 3.2.-2.

It is recommended to define a meaningful name for the release folder where to store
all the project files, project folders and project archive relevant to the actual release.
For example, a folder called "Release 3.0" contains all the projects with the version
V4F.08x, while a folder called "Release 3.0 SP1" contains all the projects with the
version V4F.09x.

It is strongly recommended to keep the project files synchronized with the
configuration files running on the REF 542plus devices.

MAINBOARD SOFTWARE UPGRADE PROCEDURE

The recommended procedure to do in case a new release or a new service pack with
a changed version number has been delivered is to remotely upgrade the
maintenance software for the REF 542plus mainboard.

For example, a project is to be updated from "Release 3.0" to "Release 3.0 SP1" and
the mainboard version from V4F.08 to V4F.09.

1. Ensure the synchronization between the release 3.0 project configuration files
and the remote configuration files currently running on the REF 542plus devices.

2. If the project is already synchronized, go to step 3; otherwise:

2.1. Open Release 3.0 Conf Tool (V4F.08)

2.2. Open "Project" from the "Release 3.0" folder

2.3. Upload all the remote configuration files currently running on devices

2.4. If there are no errors, archive "Project" in the "Release 3.0" folder

3. Create, if it does not already exist, a new folder "Release 3.0 SP1" and store the
"Project" archive to the new "Release 3.0 SP1" folder.

4. Move the configuration files to the "Release 3.0 SP1" folder with the
configuration tool

4.1. Open Release 3.0 SP1 Conf Tool (V4F.09)

4.2. Open "Project" from the "Release 3.0 SP1" folder

4.3. Do the porting: "Enter Edit" to each Config file node of the project, change
at least the language and click “Save.”

5. Send the software and configuration to the mainboard

5.1. Open the communication dialog to send the software to the mainboard

5.2. Open the communication dialog to send the configuration to the mainboard
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